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Using the MicroSet Clock and Watch Timer
with a Personal Computer

These instructions will show you how to use the MicroSet Clock and Watch Timer with
your Windows computer.  They’ll use a sample file to illustrate the different functions of
the program, so you can get started even without the timer. To work with your own
timepieces, you’ll need to plug the timer into a serial port on your computer.

To learn how to use the software, you should go through each item described in these
instructions to see what functions are available in the program. For some suggestions
of what you can do with the program, see “Using the computer interface” at the end of
these instructions. To find something in these instructions, always start with the Table of
Contents.

These instructions will teach you what the program does and how it works. At the present
time there is not a section on which function in the program you would use to diagnose
particular flaws in a clock or watch, or what specific flaws look like on the computer.
Such a book would be very useful and might be even larger than these instructions. We
would like to produce such a book when we’re able to collaborate with someone who
has worked for many years in the repair trade and knows MicroSet.

For the time being, this is the guidance I can give you --- the software interface will let
you see how a clock or watch performs over time. This is very different from taking a
single reading with the timer. A single reading is a snapshot of a moving target. The rate
of your clocks and watches is always changing. The changes are caused by irregularities
in the gear train, dirt, dried oil, inconsistency in the drive force, flaws in the escapement,
changes in the pendulum, and many other factors. Being able to record these changes
over a few minutes or several hours will not only let you get a more accurate reading of
the average running rate of the timepiece, it will reveal anomalies that are caused by the
flaws just mentioned. MicroSet is a tool that you can use to see flaws and imperfections.
But it will be up to your skill and knowledge as a clock or watchmaker to interpret the
graphs and connect them to the flaws in the mechanism.

The current versions of MicroSet go beyond the measurement and display of rate
information. They can also compare the rate with the amplitude of swing and with a
variety of environmental factors like temperature and barometric pressure to reveal how
these issues effect clocks and watches. In  addition, there are specialized functions for
the watchmaker that emulate the traditional paper tape timer, display oscillograms of
the component sounds within an individual tick, and calculate balance wheel amplitude.
The only way to learn what this program can do for you is to go through these instructions
slowly, as you’re able, to see each function decribed.

Installing the software
This version of MicroSet will work with versions of Windows from 95 to XP. Put the
MicroSet CD in your CD-ROM drive. Open a window for the CD-ROM drive and double-
click on the file “SETUP.EXE” in the Install Folder. Follow the instructions to install the
program on your computer. After installation there should be a file called
“MICROSET2x.EXE” or “MICROSET3x.EXE” on your hard disk and in your list of
Programs under the Start Menu.
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Connecting the MicroSet timer to the computer
These instructions will work with a sample file, but you'll need to connect the MicroSet
timer to your computer to work with your own clocks and watches. The software came
with a data cable for this purpose. One end of the cable has a stereo mini-plug that goes
into the jack in the timer that's labeled “Data Out”. The other end of the data cable has a
female DB-9 connector for a serial port in your computer. You will need to determine
where the serial ports are in your computer, and confirm that you have one available.

Windows computers can have several serial ports, and they're given names like COM1
or COM2. Sometimes a serial port is disabled because it's used by a modem. If you
don't have a free serial port you'll have to get one. You can tell MicroSet which COM port
to use under the CONFIGURE menu, but we’ll get to this later.

If your computer has USB ports and no old-style serial ports, you can use a USB to
Serial Converter. We have these available for a modest cost or you can buy one locally
or from a mail order catalog. Contact Mumford Micro Systems for details.

Startup
Select MicroSet from the Programs list in the Menu. The first time you run MicroSet it
will try to connect with the timer on the serial port known as “COM1”. If you will be using
the timer with serial port COM1, no adjustment will be necessary. But if COM1 is not
available a message will appear that asks you to select the COM port you'll be using
instead.  You should select the COM port you'll be using by clicking on the proper button.
You can now click on “OK” and the program will run with that serial port. If you click on a
port that’s not available, you’re get a warning message. To see what COM ports are
available in your computer, you can use the Device Manager window. To see the Device
Manager in WIndows XP, right click on “My Computer” and select “Properties”. Click on
the “Hardware” tab and then the “Device manager” button. In the list of devices that
appears, click on the “+” next to “Ports (COM and LPT)”. You should now see any COM
ports that are available.

After you confirm that MicroSet works with the COM port you selected, you can save
that configuration so MicroSet will come up configured correctly the next time you use it.
To save the configuration, go to the Setup item under the Configure Menu in the MicroSet
program and click on “Save Settings”.

If you want to run the program even though you can’t connect to a COM port, click on
the CANCEL button and the program will run, but you won’t be able to capture any new
data.

Capturing your first data
To capture rate information from your own clocks and watches, set up the MicroSet
timer to take readings in the Time Mode. The LED on the timer should blink with each
beat, and new readings should be appearing on the LCD screen. Near the top left corner
of the computer screen is an area labeled “Plot” with two settings: On and Off. Click on
the “Plot: On” button.
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The computer should now capture every new reading that appears on the MicroSet
LCD screen, and the area on the computer screen labeled “# of samples” should start
counting up.

You may not see the readings in the graph area if the scale is not correct for the rate of
the timepiece you’re measuring. Wait until there are at least three readings in the “# of
samples” and then click on the “Autoscale” icon. This will reset the Y axis to the proper
scale so the samples will fit the display area.

Each new reading of the timer should now appear on the screen of the computer. There
are many controls with which to manipulate the way the data is displayed. You can
change the type of graph and the scale of readings. You can compute averages and
show trends. But the most important use of the program is what you’re now seeing -- a
history of the rate over time. You will no doubt see that the rate readings from the timer
are not all the same, that the clock or watch speeds up and slows down. Now that you
can record these changes over time, you can see when these changes have order, and
this order will tell you about what the timepiece is doing. Are the changes random? Then
the timepiece may need cleaning or pivot work. Does the clock continually speed up
and slow down? Then any one rate reading will not be accurate, and you should find the
average to know how the clock runs over time. You will now be able to observe the
operation of your clocks and watches with much greater detail.

Learning to use the software
We have provided a sample file for you to use as we describe all of the functions in the
program. You could also use live data captured from your own clocks or watches, but
the sample file will make some explanations easier. Our explanation of the program will
be a step-by-step explanation of each command. If you have questions, don‘t hesitate
to call or send us an email.

Open the sample file
When the program starts up you will see the main screen of the program. An example of
this is shown in Figure 1. For the purpose of illustration we’ll open a sample data file.
Use the FILE menu to open the file “SAMPLE.MST” which was provided with the
installation. The extension “MST” stands for “MicroSet Timer”.

Basic display
The sample data should appear in the graph on your screen (your screen may not be
exactly identical to Figure 1 because of differences in screen sizes and types). The
sample file contains 250 readings from a simple Hermle time-only clock movement.
(Though this description will use a clock, the same operations would be used with
watches. There are, however, several watch-specific operations described later under
the Watches Menu.)

These beat readings were captured with the clip-on acoustic sensor. Each reading
represents a single beat in the clock. But we skipped every other beat. This casues the
timer to read only one pallet of the escape wheel, ticking on each tooth one after another.
To do this the timer was set to “Time: 1 (skip)”. At the left of the graph you will see labels
indicating the beat times. In Figure 1 these times are shown as “Beats per hour”, but you
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can also work with “Seconds per beat”. The MIDPOINT of the graph is set at 7996.31
BPH. This number appears in a button in the middle of the Y axis, at the left side of the
screen

Figure 1 - The MicroSet Screen

At the top of the screen you will see that the program currently holds 250 “Samples”.
This means it stores 250 different readings from the MicroSet timer. You can also see
that the last reading it received was 8138.83 BPH, and the accumulated average rate of
this clock over the entire 250 samples was 7993.315 BPH. This number is very significant.
Though the clock rate is always changing (just look at this graph), the clock hands really
show the accumulated average rate.

Set the midpoint
Look again at the button in the middle of the Y axis. This shows you the MIDPOINT of
the graph is at 7975.26 BPH. If you look near the top right corner of the screen, you’ll
see that the “Target Rate” for this clock has been specified as “8000”. The target rate is
the correct rate for the clock. To see how the data in the graph relates to the correct rate
for this clock, click on the button in the middle of the Y axis. A dialog will appear on the
screen and let you manually enter new values for the graph parameters. You will be able
to specify a new MIDPOINT for the graph, automatically set the midpoint to the current
average, or set the midpoint to the “target” rate” for this clock. You will also be able to
specify a “step size” for the grid lines. If the step size is made smaller you will, in effect,
“zoom in” on more subtle rate changes. If the step size is made larger you will “zoom
out” on rate changes. You can also zoom in and out with the up and down arrow icon
controls or with the up and down arrow keys. For now, click on “Lock midpoint to target
rate”. The graph will be redrawn with the target rate at the midpoint.

In the graph, each vertical line represents one beat reading. The beat times change
dramatically in this graph because they’re single beats recorded from the escape wheel.
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Single beats on a clock escape wheel almost always look like this. The rate increases
and then decreases with each revolution of the wheel because the escape wheel is
never perfect. You will find that watches are much more stable.

At the lower left corner of the graph you’ll see a label that tells you how much rate
change is represented by each horizontal grid line.  In Figure 1 this value is 11.3 minutes
per day. This is a very large number. What this graph is showing you is that, with each
revolution of the escape wheel, this clock speeds up and slows down by an amount
equal to more than an hour per day! (The range spans about 7 grid lines and each line
represents 11.3 minutes per day.) Note that the shapes of the cycles are nearly identical.
This is because the irregularities that change the rate are the same on each rotation of
the wheel. Though the rate is changing a lot, it changes the same way with each rotation
of the escape wheel and the average rate ends up being consistent.

At the top left corner of the graph you’ll see the message “3.1 minutes shown”. This tells
you that the data visible in this graph required 3.1 minutes to gather.

The Comment line
Directly above the graph is a framed rectangle with text in it. In the sample file this text
says “Hermle time only movement, 1 beat acoustic capture”. You can use this area to
record your notes about what the data in this file represents. To enter text in this area,
just point at it with the mouse and click. You can then enter your text. On new data files
the program automatically puts today’s date in this field. You can then add the name of
the clock that was studied or any other conditions you might want to remember (like the
type of sensor, the number of beats per reading, or the particular issue you were looking
at). Any information you enter in this rectangle will be recorded on disk with the data so
you can see it any time you open this file.

There’s a small box with an “X” in it to the left of the comment line. You can delete the
current contents of the comment line by clicking on the “X”.

You can make the comment area larger by selecting “Large Comment Window” from
the View Menu.

The Icon Controls 

Above the comment line is a row of icons. These are shortcut commands to manipulate
the graph and the data it shows. Each icon is an active button that will change the graph
in some way.

Reset         

The first icon has a red “X” in it. This is to RESET the graph. If you click on this icon all
the data will be erased. If you want to try this, go ahead. Then load the file again from
the FILE menu.
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Autoscale     

The second icon looks like a “balance” or “scale”. This is used to automatically scale the
Y axis values so the current beat times fit nicely in the window. If you click on this icon
now it won’t change because the graph is already scaled for this data.

Vertical scale     

Next to the autoscale icon are two icons that look like up and down arrows. The down
arrow reduces the vertical resolution of the graph and allows bigger (taller) values to fit.
This has the effect of “zooming out”. The up arrow increases the vertical resolution to
reveal more subtle changes in rate times. This has the effect of “zooming in”. Click on
the UP icon. The beat times seem to get bigger. This is because the step size between
grid lines has become smaller and we are more sensitive to rate changes. You can also
select these functions by typing the up or down arrow keys on the keyboard.

Click on the AUTOSCALE icon to re-scale the data to fit the screen. Now click the
DOWN icon a couple of times, until it looks like the rate doesn’t change very much in
this clock. When viewed this way, this clock looks pretty good -- even though the rate is
changing by over an hour per day with each revolution of the escape wheel! To get a
frame of reference for what kind of scale the graph represents, look at the bottom left
corner of the graph where the scale of each grid line is shown. With the data “zoomed
out” so it looks like the clock is more accurate, you’ll find that each grid line might represent
a rate change of more than an hour per day.

Hit the UP ARROW icon a few times to zoom in on the data. Watch the message at the
lower left corner of the graph, and zoom in until you get just a few seconds per day in
rate change for each grid line. In this clock, the graph will then be completely off scale.
If the clock were accurate, the rate readings would all fit on screen with each line equal
to a few seconds per day.

When you look at a graph, you must pay attention to the scale. Any clock will look
good viewed at a coarse scale, and any clock will look terrible when viewed on a
very fine scale.

Horizontal scale     

The next two icons look like left and right arrows. They’re used to expand or compress
the data graph horizontally. At the very lower left corner of the screen you will see a
scale factor. Normally this is “100%”. If you click on the  LEFT ARROW icon, the horizontal
scale will compress and this number will get smaller, indicating that not every data point
is displayed. If you click on the RIGHT ARROW icon the horizontal scale will expand to
show the entire data set. If you expand beyond 100% the data lines will get fatter. This
can make it easier to see individual items. You can also select these functions by typing
the left or right arrow keys on the keyboard.

In addition to these controls, there are commands under the View Menu to quickly
compress the horizontal scale so all data points fit on the screen or expand the scale to
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100% so every sample is visible (even though they may not all fit on the screen).

Graph type    

The next icons let you select which type of graph is used to display the data. (The third
graph type is only available in version 3). You can use whatever style you prefer. The
first type uses vertical bars to represent each sample. The advantage of the vertical
bars is that they make  it easy to see how many readings occurred between different
peaks or troughs in the data. The second graph type shows one wandering line that
follows the rate. The third graph type is used for a simulation of paper tape style watch
timing machines. You must have purchased Version 3 to get this choice. Instructions for
using the paper tape simulation will be given under the Watch Menu section.

Plot On/Off     

Above the icon controls, at the left side of the screen, is an area labeled “Plot” with two
buttons under it: “On” and “Off”. This is how you tell the program to start collecting new
data from YOUR clock timer. You must plug the data cable that came with your timer into
the jack labeled “Data Out” at the top of the timer unit. Plug the other end into a serial
port of your computer. You must know which serial port you are plugged into. You must
use the Configure Menu of the MicroSet program to tell the program which serial port
you’re using.

As you may know, the MicroSet timer can be configured to read out in either “Seconds
Per Beat” or “Beats Per Hour”. No matter how you have MicroSet configured, it will
always send data to the computer as Seconds Per Beat. If you prefer to use Beats Per
Hour, you can tell the Windows program to convert the Seconds readings from the timer
into Beats Per Hour (look under the View Menu for this command).

If your clock is far from your computer you can use extension cables for stereo
headphones to extend the reach of either your data cable or the optical sensor cable.
They both use 1/8” stereo phone plugs. You may not be able to reliably extend the
sensor cable if you’re using the acoustic sensor.

Before you start recording new data, hit the RESET icon to clear out any previous data.
Be sure the horizontal scale is set to 100%. Otherwise, you might be fooled because not
all new readings will be displayed in the compressed modes. You may even want to
“fatten up” the plot lines with the RIGHT ARROW icon to make the first few data points
easier to see.

Set the timer to the Time Mode. You may set it to any number of readings you like, from
1 to 254. Smaller numbers will give you results more quickly, larger numbers will give
you more accurate readings. But don’t use an odd number unless you have a specific
reason to. Odd numbers of beats will appear jumpy because of beat error or imperfect
placement of the optical sensor. So use “Time: 10” or “Time: 30” and don’t use “Time:
15” or “Time: 31”.
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Hit the BEGIN button on the timer to start sampling. Click the “On” button in the “Plot”
area of the computer screen. As each new rate value appears on the LCD screen of the
timer, it should also appear in the data graph on the computer. The “# of samples” at the
top of the screen should increase with each reading. To stop capturing data you can
either click on the “Off” button on the computer screen or hit the “MODE” button on the
timer itself.

The computer interface will make it easy to see that the timer readings are more accurate
when the timer is set to measure more beats (Time: 60 will be more accurate than Time:
4). If you set the timer to measure 4 beats, the graph will be jumpy. If you set the timer to
measure 60 beats, the graph will be more consistent.

The program will currently store 90,000 samples before it gets full. When it gets full, the
“Plot: On” setting will change to “Plot: Off”. If you take a reading from a one second
pendulum every minute, you will be able to capture data for more than two months
before the program fills up. If you capture a reading every hour, it will hold ten years
worth of data.

Show averages or rates     

To the right of the “Plot On/Off” area is an area labeled “Show” with buttons for “Rates”
and “Averages”. It’s possible to calculate and display two different kinds of averages
and several other manipulations on the data set. )These calculations are available under
the Operations Menu and will be described in more detail when the MENU commands
are covered.)

Storage for the alternate calculations is kept separate from the main data, and you can
switch back and forth between AVERAGE results and actual RATES by clicking on one
of the “Show” buttons. When original Rate times are displayed the graph will be in dark
red. When Averages are displayed the graph will be in blue. You can select which data
set is displayed (actual rates or averages) with the buttons in the Show area. Note that,
when a file is saved on disk, only the RATES data (the red data) is saved.

If “Averages” are selected while new data is coming in from the timer, the current average
type will be displayed for each new reading. For example, if you have selected “Running
Average”, the software will display the running average rate of a clock over long periods
of time. If you have selected “Boxcar Average”, the boxcar value will be calculated for
each new reading.

File Statistics     

To the right of the “Show: Rates/Averages” area are several statistics about the data
currently captured in the computer. First shown is the “# of Samples ”. In the sample file
provided (see Figure 1) these are 250 samples. This means that the timer completed
250 separate readings and reported them to the computer. In this file each reading was
a single beat, but if the timer had been set to average 60 beats, the 250 samples would
represent 250 readings of 60 beats each.
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The “Last Reading ” shows the last value that was returned from the timer unit.

The “Average BPH ” shows the total accumulated average rate of the clock or watch
over the study period. This value is calculated by adding all of the rate times together
and dividing by the number of samples. This reading tells you actual accumulated rate
of the clock — which is what the hands show you.

The “Target Rate ” is the correct rate for the clock under study. The program does not
calculate this value — you must enter it yourself. If you know what the correct rate for
the clock is, you can enter it here by clicking on the value shown for the “Target Rate”. A
dialog will appear to let you enter a new value. Once the program knows what the
correct rate for the clock is, it can calculate the average error of the clock.

Below the “Target Rate” is another box called “Average Error ”. It will display the amount
of error in the current data set by comparing the current average rate with the target rate
you have entered. This will show you how many seconds of error per day there are in
the current data set. A positive number indicates the clock is fast, a negative number
that it is slow. If the Target Rate is not known you should set it to zero, and the Average
Error will not be calculated.

Below the Average Error display is a box labeled “Instability ”. This is a calculation we
have created that reflects the general stability of the clock under study. To calculate the
“Instability”, each individual reading is compared to the accumulated average rate at the
time that it comes in. The “Instability” value is the average difference between each
individual reading and the average rate when the reading was taken.

If the clock is very consistent, each new rate reading will be close to the current average,
and the Instability rating will be low. If the clock is erratic, the beat times will jump around
a lot, each one will vary more from the average, and the Instability rating will be high.
Experience will teach you what to expect. On very accurate clocks the Instability will be
zero. In the sample file the Instability is rather huge, at 24 minutes per day. This means
that each individual reading is likely to vary from the average by 24 minutes per day.
This is an unfair test, however, because we are reading single beats on the escape
wheel, and we know that these are very erratic.

Below the Instability rating is the “Current time”  of day. It’s handy to have this reminder
on screen because the system clock in the computer is often wrong and needs correction.
The MicroSet program records the time of day when each sample comes in. This
information is useful because you might want to correlate rate changes to things that
happen at specific times. For example, you’ll find that some clocks speed up as the
minute hand falls from 12 to 6, and slow down as the minute hand climbs from 6 to 12.
If the times recorded from the computer’s system clock do not match the hands of the
clock, this correlation won’t be evident. Keep an eye on the time of day shown and,
when it’s wrong, correct the system clock in your computer.

At the right side of the statistics display area is a box labeled “Pend. Length” . If you
have entered a Target Rate, MicroSet will calculate the theoretical correct pendulum
length for the target rate you specified. Below this is a box labeled “Pend. Adjust” . If
you entered a Target Rate, this box will show you how far the pendulum bob must move
for the clock to achieve the Target Rate you’ve specified.



Page 12

Manipulations on the data points
Seeing individual data points
It’s possible to display the values associated with individual data points. When the mouse
pointer is over the graph window, it takes on the shape of a cross hair. If you position this
cross hair over a particular data line and click the left mouse button, a line of text will
appear at the top left corner of the graph which identifies that sample number, the value
of that sample, and the time and date that sample was acquired. You can drag the
crosshair through the data and seee diffferent data points.

Changing individual values
If you click on the right mouse button you will be given an opportunity to change the
value stored for that sample. This allows you to correct erroneous readings. You can
either enter a new value manually, let the program automatically calculate the average
of the two adjoining points, or delete the sample.

Measuring a range
If you hold down the left mouse button, then drag from one data point to another and
release the mouse button, the text display will show you the number of samples that
were spanned by your selection, the amount of change from beginning to end, the average
value of the samples you spanned, and the time difference between them. This allows
you to identify the time intervals that produce visual effects in the data graph. For example,
in the sample file, you can see that the period of the peaks is 25 samples. This means
(with this setup) that the escape wheel has 25 teeth.

As you drag over the data, the screen will show you the information about each individual
sample you pass over. If you wish to see the summary of the range as you drag the
mouse, hold down the SHIFT key while you drag.

Delete a sample
Once you have specified a single data point by clicking on it with the left mouse button,
or a range of points by dragging over them, you can delete them from the data set by
hitting the DELETE key.

Arrow keys
The arrow keys on the keyboard have the same effect as the arrow icons to expand or
compress the horizontal and vertical scales of the graph.

If you hold down the CONTROL key when you press the up or down arrow keys, the
midpoint of the graph will change rather than the vertical scale. This has the effect of
letting you see data that’s above or below the top and bottom edges of the graph.

Normally, when you press the left or right arrow keys, the horizontal scale of the graph
will expand or compress by a factor of two. If you hold down the SHIFT key when you
press the right or left arrow keys, you can expand or compress the horizontal scale of
the graph in smaller increments.

If you hold down the CONTROL key when you press the right or left arrow keys, the
display will scroll right or left by the size of one screen width. This has the effect of letting
you see what’s beyond the right or left edges of the graph.

If the screen is in a compressed horizontal scale, the indicator at the bottom left corner
will say something less than 100%. You can automatically expand the scale to 100%
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and set the left border by holding the CONTROL key down and clicking on any data
point. That data point will be placed at the left border of the graph.

Setting the left viewing margin
There is a small button in the lower left corner of the screen, just below the labels on the
Y axis. This button normally has the number “0” in it. This is the left margin of the samples
you can view. MicroSet can capture up to 90,000 samples, but Windows will not let a
scroll bar manipulate more than 32,767 samples. If you capture a huge data file (larger
than 32,767 samples) you can click on this Left Margin Button and set the left margin to
an offset. For example, if you set the left margin to 10,000, you’ll be able to view and
scroll through samples 10,000 to 42,767.

Redraw the screen
You can redraw the current data by  clicking on the text box which shows the current
number of samples.
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The MENU Commands
——————————————————————————————————————
The FILE Menu
The File Menu lets you store and retrieve data sets.

Open  lets you open a data file that has been previously saved on disk.

Save lets you save current data file on disk.

Save As  lets you save current data file on disk with a new name.

Save A Subset As
This command lets you save a subset of the current data file on disk with a new name.
The purpose of this command is to reduce the size of a data file. For example, suppose
you captured a data file with a new sample every minute for a week. At the end of the
week, you would have over 10,000 data points. Let’s further suppose that, when you
examine the data, you find that one sample each hour would have been adequate. This
command will let you save a file with only one sample per hour.

When you select Save A Subset As you will be asked to enter the number of samples
you wish to skip for every sample saved. For example, to save one sample every hour
from a file of one sample every minute, you would enter 59 -- for every 60 samples, one
will be saved. To save one sample every ten minutes, enter 9. The smaller file is saved
under the name you give it. The file in memory is not changed. If you wish to see the
smaller file, you must open it with the OPEN command.

Print lets you print an image of the current graph on your printer.

Exit  terminates the program and returns to Windows.

The View Menu
The View Menu gives you several commands that manipulate the graph.

Fit in window
This will compress the horizontal scale as necessary so that the entire duration of the
current file will fit on the screen. This lets you step back and look at the overall result of
the entire sample period.

Expand to 100%
This will expand the horizontal scale to 100% and lets you see every data point that will
fit within the screen width.

Setup Sensors and Amplitude
This selection will allow you to display pendulum amplitude and rate simultaneously if
you have a MicroSet 3 with this feature. This feature was not available before October
of 2004, but if you have an earlier timer it can be upgraded.

If you bought an optional temperature or atmospheric sensor for MicroSet, This function
will allow you to configure and display the readings for these sensors on the computer
screen.
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When you click on Setup Sensors and Amplitude, the dialog shown in Figure 2 will
open. This dialog is used to configure all of the optional display settings.

Figure 2 – The Sensor Settings

There are controls areas for four sensors and one for the pendulum amplitude. The
“Temperature” sensor is the single temperature sensor sold for MicroSet. The “Barom-
eter”, BaroTemperature”, and “Humidity” are provided by the MicroSet Atmospheric
Sensor. These are both optional sensors that can be ordered from Mumford Micro Sys-
tems.

There are several settings every sensor has in common. At the top is a check box where
you can set whether the display for that item is enabled or not. An item must be enabled
to be visible in the graph.

Below this is a “Color” box. If you click here, you can change the color that’s assigned to
that item. You will use different colors to differentiate the different elements in the data
graph.

You can also set the midpoint and step size for each item, just as you can for the clock
rate data. If you aren’t sure what values are appropriate, you can click on “Autoscale”
button to automatically scale the display to fit in the graph window.

Finally, each item can be displayed as a line graph or bar graph, like the main rate data.

After you have configured the settings you can click on the “Apply” button and preview
the selections you have made in case you want to make further adjustments before you
put the Sensor Setup dialog away. Or, you can just click on “OK” and the graph will be
updated with the new settings.

Displaying the amplitude of swing
Beginning in October of 2004, MicroSet 3 is able to display the amplitude of a pendulum
at the same time as it displays the rate of the pendulum. It does this by measuring the
amount of time  the sensor is triggered at the end of each reading. It works with optical
or magnetic sensors, but not with the acoustic sensor. To see this data, you must enable
the Amplitude section of the Sensor Setup dialog shown in Figure 2.

Usually, when measuring a pendulum, you put the sensor at the center of swing. In this
configuration, if the pendulum swings wider, it will pass through the center of swing
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more quickly. This is indicated by a shorter length of time that the sensor is triggered. If
you enable the amplitude display, the timer will measure the relative speed of the pen-
dulum as it passes through the center of swing. As the pendulum swings wider, the
reading will get smaller. This is confusing when it’s plotted on the graph because we
tend to associate larger values with greater amplitude. There is a check box in the
Amplitude section of the Sensor Setup dialog labeled “Invert”. If you click on “Invert,”
smaller values will be plotted at the top of the graph to better represent larger amplitude.

When measuring the amplitude with a sensor at the center of swing, the readings are
relative and not absolute. You will easily see when the amplitude gets larger or smaller,
but you have no way to calibrate these changes or associate them with any absolute
amount of swing.

The amplitude can also be measured by placing the sensor at one side of the swing.
The sensor must be located very near the maximum amplitude of the pendulum, and it
must be arranged so that the sensor will be triggered every time the pendulum reaches
it. But the pendulum must not swing beyond it, so the sensor becomes untriggered for
an instant before the pendulum swings back. If you’re using an optical sensor, it may
help to add a bit of opaque tape to the pendulum tip to make it wider and be sure the
sensor stays blocked the whole time. Or, you might arrange the optical sesor to trigger
on the edge of a disc-shaped bob. If you’re using a magnetic sensor, a larger magnet
will have a larger field to trigger the sensor.

Keep in mind that, with the sensor at the side of swing, the rate measured by MicroSet
will be the period of the pendulum (two swings) rather than the beat time. So a one
second pendulum will have a rate reading of two seconds.

In this configuration, when the pendulum swings wider, it spends more time at the end of
the swing. A larger reading corresponds to a larger amplitude, so you should not check
the boxed marked “Invert” in the Sensor Setup dialog.

Figure 3 shows a graph with both rate and amplitude. The taller wave is the rate, the
smaller wave is the amplitude. In this clock the change in rate is caused by the minute
hand, which speeds up the clock as it falls from twelve to six. As it speeds up the rate,
the amplitude begins to increase as well, though it lags the rate. When the minute hand
reaches the six and must be hauled back up to twelve, it takes more energy from the
clock, the rate slows down and, after a while, the amplitude declines too.

You can also convert these readings to a good approximation of the actual amount of
swing. At the right side of the Amplitude section of the Sensor Setup dialog is a box
labeled “Smith Method”. The Smith Method was devised by Dr. David Smith at the Uni-
versity of Auckland in New Zealand. It uses trigonometry to convert the timing informa-
tion to actual degrees of half swing. It relies on the assumption that the pendulum swings
in a sinusoidal motion. Any divergence from this shape will distort the readings. The
results of the Smith Method may not be correct to very small decimal places or in clocks
whose motion is disturbed at the side of swing where the measurement takes place (like
a gravity escapement). But in most cases you will be unable to distinguish any differ-
ence between the calculated amplitude and any value you can manage to read directly.
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Figure 3 – Pendulum rate and amplitude

To apply the Smith Method you must enter two parameters. You must enter the “Height”,
which is the vertical distance from the pivot point of the suspension to the sensor. If you
wish to be precise, and you’re using a magnetic sensor, the distance is from the pivot
point of the suspension to the point at which the magnetic field triggers the sensor. Such
small distinctions are probably insignificant. Even if your measurements are not high
precision, the results will be approximately correct.

You must also enter the “Width”, which is the horizontal distance the pendulum must
travel from its at-rest position to the trip point of the sensor. When you have entered
these two values, MicroSet will have what it needs to perform the Smith calculations
and new amplitude readings will be stored as degrees of swing.

There is also a radio button that lets you choose “Angular” or “Linear”. If the Angular
button is selected, the stored readings will be degrees of half swing. If the Linear button
is selected, the readings will be converted to horizontal offset from the center of swing in
whatever units you used to enter the Height and Width. (You can use either inches or
metric units.)

When you have entered this information and MicroSet calculates the amplitude, the
readings are stored as calculated. If you enable the Smith Method and calculate de-
grees of half swing, you can’t go back later and view the amplitude as inches of offset or
as raw time values. So be sure to configure the amplitude display for the way you want
to view it in the beginning, before you collect the data.

Manipulating the display of sensors and amplitude
Once you have turned on the sensors or amplitude display, the main graph window will
have some new controls in the top right area. These can be seen in Figure 4. Addition-
ally, the right side of the graph will become annotated with values for the sensor or
amplitude readings.
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Figure 4

At the top  right corner of the screen you will see current settings for the sensors. If you
don’t have a sensor, the reading will be zero. In Figure 4, there is no Temperature
sensor.

To the left of this is a rectangle with radio buttons for each sensor or the amplitude that
you have enabled. The color of the label indicates the color of the data in the graph. The
radio button selects which sensor is currently “active”. In Figure 4, the Barometer is
“active”. When a sensor is active, the labels on the right side of the graph reflect the
readings for this sensor. The reading at the middle of the graph is a button you can click
on. If you click on this button, you can reconfigure the settings for this sensor.

Under the current sensor readings at the top of the screen are four small buttons labeled
“+”, “–”, “Up” and “Down”. These are used to arrange the data in the graph. If you’re
plotting several parameters simultaneously, it’s important to be able to rearrange the
scale and location of each element to make a readable graph. These four buttons simplify
that task. They will effect whichever sensor is currently active, as determined by the
radio buttons. To zoom in on a sensor (or amplitude) reading, click the “+” button. To
zoom out, click the “-” button. To move the data set higher in the graph, click “Up”. To
move it lower, click “Down”. There’s also a radio button for the “Clock Rate”, so you can
manipulate its scale and position too. Use these buttons to arrange the data so it’s more
legible in the graph.

If you hold down the Shift key when you click on one of these four buttons, the action of
the button will be reduced to a finer scale.

Show/Hide gridlines
This selection under the View Menu is “Show/Hide gridlines”. You may find that, when
you have data on the screen for the rate, the amplitude, and a few sensors, the gray
gridlines become distracting. You can turn the gridlines on or off with this menu item.

Large comment window
This selection under the View Menu will enlarge the size of the comment area, so you
can enter a longer description of the data you are viewing.

Display custom legend
This selection under the View Menu will display a special message you might want to
appear on each graph. The message that appears can be specified with the Setup
command of the Configure menu. For example, you might want to display the name of
your business if you give printouts of the graphs to your customers.



Page 19

Show seconds per beat
This command will configure the graph to display rate data in the form of Seconds Per
Beat. This is the default format for the graph. For example, a one second pendulum
would have a beat time of 1.000000 seconds per beat. The Y axis is labeled to six
decimal places.

Show beats per hour
This command will convert the beat times from “Seconds Per Beat” to “Beats Per Hour”
if you are more comfortable using these values. A one second pendulum has a rate of
3600.00 Beats Per Hour.

Show error per day
This command will label the Y axis in terms of error in seconds per day. To perform this
calculation you must have entered a "Target Rate" at the top right corner of the screen.
When this mode is selected, the midpoint will be set to the target rate and displayed as
Seconds Per Beat or as Beats Per Hour, whichever is the current mode. Each grid line
will be labeled as error in seconds per day from the specified target rate. If the error is
too great to be reasonable, the program will not enter this mode.

Show microseconds
This command is similar to "Show seconds per beat", except that the values on the Y
axis are shown as microseconds of offset from the midpoint. In other words, instead of
showing "1.000010" (seconds), the Y axis shows "10.00" (microseconds). This makes it
easier to understand the Y axis labels when the increments are small. The midpoint is
still shown as seconds per beat to six decimal places. If the vertical step size is too
large, the program will not enter this mode.

Show milliseconds
This command is similar to "Show microseconds", except that the values on the Y axis
are shown as milliseconds of offset from the midpoint. In other words, instead of showing
"1.010000" (seconds), the Y axis shows "10.00" (milliseconds). This makes it easier to
understand the Y axis labels when the increments are in this range. The midpoint is still
shown as seconds per beat to six decimal places. If the vertical step size is too large,
the program will not enter this mode.

Show pendulum amplitude
This command will allow you to set up the timer to measure and display the amplitude of
a pendulum rather than its rate. Changes in pendulum amplitude suggest changes in
driving power of the escapement, or changes in power losses within the movement.

This function predates the newer ability to show amplitude and rate at the same time,
which was described under “Setup Sensors and Amplitude”. We leave this function in
the software because not everyone can use the newer feature.

Note there is a separate function to show the amplitude of watch balance wheels. This
will be described under the Watches Menu.

The setup and calculations for this function were devised by David Smith, professor of
mathematics at the University of Auckland in New Zealand. There is a specific procedure
that must be followed to produce this information. The computer needs a couple of
measurements to make the calculations, and these are entered in a dialog box which
appears when you select “Show Amplitude” from the View Menu. If you don’t bother to
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enter these measurements, you can still capture changes in amplitude, but they won’t
be calibrated in degrees.

First you must position the optical detector to one side of the exact center of swing. Try
to locate the sensor about 80% of the way from the center of swing to the maximum
amplitude of swing. This proportion is not critical, but don’t get too close the point of
maximum amplitude. Also, the measurements will be more accurate if the “flag” which
triggers the optical sensor is as thin as possible. You may wish to apply a very thin strip
of opaque tape to the bob, which will trigger the sensor. This strip can be as narrow as
.05”.  Now you must measure the horizontal distance from the center of swing to the
center of the sensor. This value is called “sensor offset”, and you can measure in either
inches or millimeters. For now, just write this number on a slip of paper for reference.

You must also enter the vertical distance from the optical sensor to the effective center
of rotation (or point of suspension) of the pendulum. This value should be in the same
units (inches or millimeters) as the sensor offset. This value is called the “vertical offset”.
Make this measurement and write it on a slip of paper for reference.

You must also enter the actual rate of the pendulum. This is not necessarily the correct
rate for the pendulum, but rather the current average rate. In other words, if you’re
working with a one second pendulum and the current rate is 1.000014 seconds, this is
the number you should enter. The first time you configure the “Show amplitude” mode,
MicroSet will automatically put the current “average rate” into the correct location. You
can let MicroSet determine the current average rate by logging conventional rate readings
on the clock for a while. You can do this with the sensor in the off-center position if you
like. Just be sure the timer is set to measure a relatively large number of even beats
(“Time: 30” or “Time: 60”).

Figure 5 – The Show Amplitude Window

Once you get a pretty stable average rate, select the “Show amplitude” function from
the View Menu.  A dialog box will appear in which you must enter your measurements.
Enter the horizontal sensor offset as well as the vertical sensor distance. If the correct
beat time is not entered automatically, and you know what it is, you can enter it manually.
When all three values are correct, click on the BEGIN button. It’s a good idea to record
the sensor offset, the vertical offset, and the average rate in the comment box above the
graph. These values must be entered again if you wish to view the data at a later time.
The software stores the raw time values, not the calculated result. A good place to
record these values is in the comment line of graph. Then they will always be stored with
the data itself.

You must now set MicroSet to read single beats, but skip every other one. In other
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words, set the timer to show “Time 1 (skip)...” on the LCD screen. This setting is below
“Time 1...”. If your timer does not have a “Time 1 (skip)...” setting, the setting of “Time
1...” is correct.

Watch the pendulum, and press the BEGIN button on the timer when the pendulum is
swinging towards the sensor from the long side. For example, let’s say you moved the
sensor to the left of center. The left half of the swing will now be short, the right half will
be long. Start the timer when the pendulum is swinging to the left, before it reaches the
sensor. You want the single beat that the timer measures to be the short portion of the
off-center measurement. MicroSet will begin to display the amplitude of the pendulum
swing in degrees. The display will not show degrees and minutes, it will show degrees in
fractions to 6 decimal places.

You will probably need to click on the “Autoscale” icon to get the data to present itself in
proper scale on the screen. Since the timer is set to read out single beats, you’ll get a lot
of data (one reading every two beats).  This is probably more than you need, but you
can use the “Skip samples” or “Pre-average new data” functions (see the OPERATIONS
menu) to reduce the volume of data.

While in the “Show amplitude” mode the data will be displayed in light blue color. The
“Show averages” message on the screen will change to “Show amplitude”. The raw rate
readings that the timer returns are stored in the red primary data area (“Show rates”) of
the program. The amplitude calculations are stored in the alternate data area (“Show
amplitude”) of the program.

If this setup is done with only very rough measurements, the resulting data will still give
a very accurate indication of the way the amplitude is varying, even though the scale of
the readings may not be exact.  You can easily see changes in amplitude of just a few
seconds of arc. For comparison, the angle that the hour hand of a clock turns in one
second is 30 seconds of arc.

To turn off the amplitude calculations, select “Show amplitude” from the View Menu and
click on the STOP button.

Show Rate Finder
This command is used to display the results of the optional Rate Finder. The Rate
Finder is a way of automatically counting the correct BPH of a running pendulum clock.
The Rate Finder will count the number of pendulum swings in one rotation of the minute
hand. This, by definition, is the correct Beats Per Hour of the movement. If you purchased
the Rate Finder, you can capture each hour’s beat count on the computer screen. The
Show Rate Finder Mode sets the Y axis to display whole numbers in ascending order.

Show Raw Data
There may be times when you want to display data that isn’t clock rate information. For
example, you might want to record the “Width” function, which records the amount of
time a sensor is triggered. “Show Raw Data” will format the scale of the graph for data
values in several formats. The data can be displayed with no decimal places, with three
decimal places, or with six decimal places. Furthermore, the data will be displayed with
large values at the top. (When displaying clock rate as seconds per beat, MicroSet puts
smaller numbers at the top because these are faster than large numbers. In the “raw”
format, large numbers are always at the top.)
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The OPERATIONS Menu
This menu provides several commands to alter either the data stored in memory or the
way the data is gathered.

Running average
The  Running Average is the accumulated average rate of the clock or watch at each
sample point. This is, in effect, what the clock or watch hands show you. When you
select this command, the program will go through the data and add each value together.
At each position it will divide the current sum by the number of samples in that sum. The
average results are stored in the “alternate” (blue) data area. You can switch between
the Running Average and actual Rates by clicking on the “Show Rates” or “Show
Averages” buttons at the top left corner of the screen. When the average values are
shown the color of the graph changes from red to blue and the “Averages” button in the
“Show” area at the top left corner of the screen is selected.

Figure 6 - Running average

The hands of a clock show the accumulated average rate. We have seen that individual
samples from a clock will vary over time, and that higher settings of the MicroSet Time
Mode produce more consistent readings (you get more accurate results if you set
MicroSet to “Time: 60”  than if you set it to “Time: 2”). For similar reasons, if you let a
timepiece run in the average mode for half an hour you’ll get a much better idea of what
the rate of that clock or watch really is, because the fluctuations of rate that occur over
shorter periods are averaged out.

For a demonstration of this, load the sample file SAMPLE.MST. Select “Fit in window”
from the View Menu to get the entire data set on the screen. Click on the SCALE icon to
set the vertical scale for good viewing. Once again you see the strong cycles of the
escape wheel. Now select “Running Average” from the OPERATIONS menu. You will
see that the strong wavy shape of the data is quickly dampened to a gradual slope that
reaches an average rate. This is really how this clock runs. Each reading is very different
from it’s neighbors, but over time these changes average out to a “flat” rate. But the rate
is never truly flat. There are always changes happening in the movement to produce
irregularities.

Once you set the software to show the running average you can leave it alone, and all
new readings will automatically be averaged before they are plotted. In this way you can
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just let a clock run for as long as you like and you’ll be able to easily see when the
average rate has become stable.

Boxcar average
This is also known as a “moving” average. When you select this command, a window
will appear and ask you for the “boxcar” size. Enter a number, and after you click on OK,
the program will go through the data and average the last “boxcar” number of samples
and store the average of those samples at the last position. It will then average the
previous “boxcar” number of samples and store the average at the next-to-last position.

Example:  Imagine a data file with 100 samples. If you enter a boxcar size of 10, the
value of sample 100 will be set to the average of samples 91 through 100. The value of
sample 99 will be set to the average of samples 90 through 99, and so on. The average
results are stored in the “alternate” (blue) data area and the original readings are
preserved in the main (red) data area, so you can perform the boxcar calculation over
and over with a different boxcar size to see different results.

You can view either Rates or Boxcar Averages by clicking on the “Show Rates” or “Show
Boxcar” buttons at the top left corner of the screen. When the Boxcar Average values
are shown the color of the graph changes from red to blue, the label “Averages” changes
to “Boxcar”,  and the “Averages” button in the “Show” area at the top left corner of the
screen is selected.

The effect of the Boxcar Average is to reduce short term fluctuations of rate. THis is also
called a “low pass filter”. The Boxcar Average will smooth out the jumpiness of each
reading, but will allow you to see when the rate is generally speeding up or slowing
down. By choosing increasingly large boxcar sizes, you increasingly reduce the effect of
short term fluctuations and increasingly reveal longer term fluctuations that might
otherwise be hidden in the data.

Figure 7 - Boxcar average

To see for yourself, open the SAMPLE.MST file. Select “Fit in window” from the View
Menu to get the entire data set on the screen. Click on the SCALE icon to set the vertical
scale for good viewing. The dominant effect you see are 10 cycles of the rotation of the
escape wheel. We want to remove (average out) these strong cycles. First we need to
know how many samples are in each cycle. Move the crosshair over the tip of one wave
and press the left mouse button. Drag the crosshair to the tip of the next wave and
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release the mouse button. The text at the top of the graph will tell you that you have
selected 26 samples. But this includes the tip of both cycles -- one complete cycle is one
sample less, or 25 samples.

Now choose “Boxcar average” from the OPERATIONS menu and enter a boxcar size of
25. This will completely average out the escape wheel cycles because they have a
period of 25 cycles. Click on “OK”. You’re left with a slowly sloping wave that represents
more accurately the average rate of the clock. It’s now evident that there is some other
major rate change going on in this clock that’s unrelated to the rotation of the escape
wheel. This is evidenced by the hump near the middle of the graph. In the 3.1 minute
interval of this short sample the rate changed by about 30 minutes per day due to this
other, as yet unknown, effect.

Difference / Rate of change
This command will examine the data and show you the difference between each
subsequent reading. It gives you a way of analyzing how a timepiece is changing as
opposed to what it’s absolute rate is.

When you select this function the data graph will turn blue to indicate that you’re looking
at the “alternate” data area. The raw rate information is undisturbed in the red (main)
data area. The midpoint of the graph is set to zero, and each reading is displayed as the
difference between it and the preceding sample. Values are shown as seconds to six
decimal places.

An example of use for this function would be to reveal damaged escape wheel teeth.
When a tooth is flawed, it is likely to produce an abnormal beat time. By displaying the
differences between single beats, such effects are easy to spot. In our sample file, one
tooth stands significantly taller than the others. This bit of information was not evident in
the other display modes.

Figure 8 - Difference / Rate of change

Percentage change
This command is very similar to the previous one, but it shows you the readings as a
percentage of change from the previous value rather than as absolute fractions of a
second.
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Gain/Loss
This command will convert the rate of a clock into the absolute gain or loss in seconds
of time. Up to now we’ve been viewing the data in terms of how fast or slow each beat is.
This command shows us how fast or slow the whole clock is over time. The midpoint of
the graph is set to zero, and each reading is displayed as how fast or slow the clock is at
that instant. In other words, if the clock has lost a second by reading 150, sample 150
will have a value of 1.0. Positive numbers indicate loss, negative numbers indicate gain.

Figure 9 – Gain/Loss

In our sample file, the Gain/Loss function shows that the clock is generally gaining, but
the gaining rate is moderated by the fact that the escape wheel speeds up and slows
down with each rotation. By the end of our 3 minute interval, the clock has lost about a
quarter of a second.

One way in which this function could be useful is as follows. Suppose you have a clock
that doesn’t keep time. Suppose you’ve used MicroSet to adjust the rate, but the clock
still loses time. The problem could be that the hands are slipping even though the clock
is beating correctly. If you set the clock to the correct time and let it run for a few hours
or longer, you can compare the amount of time the hands show have been gained or
lost with the amouint of time that the computer tells you have been gained or lost. The
computer will give you the answer according to the beating of the clock. The clock will
give you an answer according to the motion of the whole clock. If the results are not the
same, there may be a problem in the motionwork.

Instability history
This command will show the history of “Instability” readings throughout the measurement
period. You will recall that the “Instability” parameter (shown near the top right of the
screen) gives some indication as to how consistent a movement is. The “Instability”
figure usually shows the final, total Instability value for the movement. The Instability
History will calculate the Instability value for each sample in the file and display them in
the alternate (blue) data area. This command was added at the request of a customer,
who thought it would be useful in finding cycles within a movement when the rate was
disturbed by some flaw. No such irregularity appears in our sample file; the Instability
reaches a consistent value and stays there.
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Figure 10 - Instability History

Remove noise
This command will eliminate samples that are so far out of scale with the other readings
that they can only be attributed to “noise” -- either actual acoustic noise that disturbed
the acoustic sensor, or a data error with the optical sensor that can’t be right. To use this
command, scale the data on screen so all the legitimate samples easily fit between the
top and bottom boundaries of the screen, and the flawed data points extend off the
screen. When you select “Remove noise”, any data point that is outside the range of the
maximum and minimum values on the Y axis are set to the average of the two neighboring
points.

Use this function with care. Don’t be too quick to judge that a data point just CAN’T be
legitimate. Sometimes these outliers are real, and evidence of unexpected behavior.

Pre-average new data
This command will average several readings internally before it plots a new value on the
screen. It was added to facilitate certain kinds of experimental work. It’s basic operation
allows you to take readings for much longer periods of time. When you select this
command, a dialog will appear and ask you to enter the number of samples you want to
pre-average. Let’s say you enter 60. The software will then take 60 readings from the
timer, average them together, and plot the result. If the timer had been set to “Time: 60”,
you would  get one data point in the graph for every 3600 beats of the clock or watch. In
this way you can multiply the Time Mode setting of MicroSet and get readings over
intervals much longer than the usual limit of “Time: 254”. This lets you capture data for
very long periods of time without collecting a large number of samples. It’s easy to
forget that the pre-average is on, however, so try to remember when you use it. To
disable pre-averaging, set the value to zero.

Skip samples
This command is similar to "Pre-average new data", except that it simply skips a specified
number of samples rather than averaging them together before they're recorded. In
most cases, you’ll want to “pre-average” readings rather than skip them because you
care about what the clock is doing between readings. Sometimes, only the reading you
take matters, and the ones in between should be ignored.
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This command is primarily for use with the GPS interface. The GPS interface gathers a
new data sample every ten seconds. This is probably too much data to store, so you
can skip readings you don't need. You don't want to average the skipped readings from
the GPS interface, however. Maximum accuracy is achieved with a simple reading of
immediate GPS offset. If you skip five readings you'll get every sixth one, or one reading
every 60 seconds. If you skip 359 readings you'll get one reading every hour.

This command is also used with the “Show Amplitude” function. When measuring the
amplitude of a pendulum, each reading stands on its own. You don’t want to average the
amplitude between readings, you probably want the amplitude at the instant it is recorded.
However, if you want the average amplitude over an interval, use the “Pre-average”
function rather than the “Skip samples” function.

Modify datasets
This command will allow you to modify the data stored in the program. There are a
couple of uses for this function. For example, let's suppose you have gathered several
days worth of rate data on a very accurate clock and the clock is running fast by 10
microseconds per beat. Perhaps you'd like to evaluate variations in the clock performance
as if it were running exactly to rate. You can simulate this adjustment to the pendulum by
adding 10 microseconds (.000010) to every rate reading.  The result will represent how
the clock rate would look if it were possible to correct the average rate without disturbing
the clock whatsoever. The inherent fluctuations will still occur, we simply raise or lower
the bob “mathematically” as opposed to actually.

If you're using the GPS interface, you're collecting drift in the clock rather than rate
values. If the clock is running slow, it will continue to drift farther and farther from the
GPS reference. Perhaps you'd like to evaluate your data as if the clock were not drifting.
This can be simulated by subtracting an accumulating amount from each drift reading.
As above, this will produce a "mathematical" adjustment to the pendulum length without
disturbing the characteristics of behavior.

There are two data areas in MicroSet -- the "main" data area and the "alternate" data
area. The main data area appears red, the alternate data area appears blue. When new
data is captured it is stored in the main data area. When you save a file, it is the main
data area that gets saved. The alternate data area is used for some of the calculations,
like "Boxcar average" or "Running average". The alternate data area also stores the
results of the "Modify datasets" command.

Figure 11 - Modify datasets dialog
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The "Modify datasets" command brings up a dialog where you can select several options.
Two buttons let you choose to modify the main dataset  or the alternate dataset . Which
dataset you modify depends on what you want to do. If you modify the main dataset, the
results of your modification will be stored in the alternate data area so your original data
will not be lost. If you modify the alternate dataset, the results will be stored back into the
alternate data area and overwrite the data you operated on.

A text box lets you enter the Amount by which to adjust the dataset. The number you
enter will be added to every value in the dataset. To subtract a value, enter a negative
number.

A check box lets you choose to have the program automatically enter the amount of
correction needed to bring the current midpoint of the graph to the specified target
rate . This is useful if you have rate data captured for a watch or clock that’s not running
exactly on time. Set the midpoint of the graph to the current average rate. Be sure the
correct rate of the watch or clock has been entered in the “Target Rate” area. If you
check the box “To bring midpoint to target”, the value needed to bring the average rate
to the target rate  will be calculated and entered in the AMOUNT field.

A check box lets you choose whether or not to have the AMOUNT "accumulate". If you
click on "Accumulate amount", the amount you enter will be added to the first data
element, twice that amount will be added to the second data element, three times that
amount will be added to the third data element, and so on. This function is used with
offset times from the GPS interface to remove drift.

When you have the MODIFY DATASETS dialog configured the way you want, click on
"OK". The operation will be performed and the results will be shown to you in the alternate
data area (the blue dataset). If you modified the main dataset, you can do it again, as
many times as you like with different values, because the main data area is left unchanged.
If you modified the alternate dataset, you will have overwritten the previous values in the
alternate data area.

Exchange data sets
This command will let you exchange the normal (red) data set with the alternate (blue)
data set. When you save a file in MicroSet, only the normal (red) data area is saved. If
you want to store the result of some operation that has put data in the blue data area,
you will need to exchange the data sets to get the values in the red data area before you
save the file. Keep in mind that, if you exchange data sets and then save the file, your
raw original data will not be stored on disk. If you wish to preserve the original data, be
sure to save it on disk before you exchange it for the result of some calculation.

Change time stamps
Every time a reading is captured by the Windows interface program and stored, the time
of day is recorded for that sample. This allows you to go back later and correlate changes
in the data with motion of the clock or watch hands, the temperature in the room, etc. If
the clock in your computer is set correctly, the time stamp will usually be correct. If you
notice that your computer clock was wrong after you’ve collected some data, this
command will let you correct the time stamps in your data file. Or, if you have purchased
the optional Data Capture memory for MicroSet (which allows you to capture readings
while you’re away from a computer), you will need to reset the time stamps of the captured
readings.
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Figure 12 - Change timestamps

When you select this function, a dialog will appear that lets you enter the conditions for
time stamp calculation. You must enter the date of the first sample, the time of day of the
first sample, and the number of beats between each sample. This last number may
require a little thought.

If you had MicroSet to “Time: 30” then there would be 30 beats between each sample
unless  you also had the Windows Interface Program set to pre-average or skip some
samples. If you had MicroSet configured to “Time: 30” beats and the Windows program
set to Skip 29 beats, there would be 900 beats per sample. This is because there were
30 beats that you got a reading from, and “29 times 30” more that were skipped.

If you’re using the MicroSet Data Capture memory, you may also need to think about
how many beats per sample there are. If you had MicroSet configured to “Time: 30”
beats and had the Data Capture set to “10”, you would capture one reading after 30
beats and you would not capture the next “9 times 30” beats. In other words, there were
300 beats per sample.

After entering the correct parameters, click on the “Change” button and the timestamps
in the file will be changed. You will see no outward effect, but the time stamps can be
viewed by clicking the left mouse button when the cursor is over a data sample.
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The Controls Menu
This menu makes many of the commands that are usually accessed with mouse clicks
available as menu items. This is a convenience for people who prefer to use the keyboard
rather than the mouse.

Plot On
   Starts capturing readings from the timer.
Plot Off
   Stops capturing readings from the timer.
Show Rates
   Displays the main data area (the red data).
Show Averages
   Displays the alternate data area (the blue data).
Refresh display
   Redraws the graph
Recalculate average
   Recalculates the Average Rate value
Delete all data
   Empties the graph. Same as clicking on the red “X” icon.
Autoscale
   Scales the data to fit on the screen. Same as clicking on the red autoscale icon.
Reduce vertical scale
   Compresses the vertical scale. Same as clicking on the down arrow icon.
Move down
   Moves the data lower on the vertical scale.
Increase vertical scale
   Expands the vertical scale. Same as clicking on the up arrow icon.
Move up
   Moves the data higher on the vertical scale.
Halve horizontal scale
   Compresses the horizontal scale by half. Same as clicking on the left arrow icon.
Reduce horizontal scale
   Compresses the horizontal scale by a small amount.
Double horizontal scale
   Doubles the horizontal scale. Same as clicking on the right arrow icon.
Expand horizontal scale
   Expands the horizontal scale by a small amount.
Bar graph
   Displays the data in column format. Same as clicking on the bar graph icon.
Line graph
   Displays the data in line format. Same as clicking on the line graph icon.
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The Watches Menu
This menu has a set of features especially for watch work. You will not have this menu
unless you purchased version 3 of the Windows Interface Software.

Paper tape simulation
This remarkable features allows MicroSet to simulate an early paper tape style of watch
timing machine, like Vibrograph and Tickoprint. These machines printed a dot on a
paper tape for each beat of the watch. You could tell if the watch was fast or slow, and
many other things, by analyzing the pattern of dots. Many people have become skilled
in the use of these machines. MicroSet will allow you to perform the same kinds of
analyses on the computer screen but with much greater accuracy, flexibility, and more
quietly.

To use the paper tape simulation, put MicroSet in the mode to read a single beat: “Time:
1”. Do not use “Time 1 (skip)”. On the LCD screen you will see individual beat times
changing very quickly with each beat of the watch.

At the computer, under the Watches Menu, choose “Paper tape simulation”. MicroSet
will ask you for the correct rate of the watch in Beats Per Hour. Enter this value and
MicroSet will switch to the “double-dot” style of graph display. It will set the graph to
display zero beat error at the center of the screen with a spacing of two milliseconds per
grid line. Tell the program to begin taking readings by clicking on “Plot: On” at the top left
corner of the screen. MicroSet will now show you each beat of the watch as a dot on the
screen. If the watch is running close to rate and with little beat error, these settings will
allow you to see the watch performance easily. You should see two nearly parallel lines
similar to Figure 13.

Figure 13 - Paper tape simulation
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You may need to adjust the Level control on MicroSet to get the best result. I have found
that a setting near 2 o’clock is sufficient on most watches, but you may wish to turn it all
the way up. You may wish to adjust the Level control while you watch the computer
screen. There are three primary components to a watch tick. If the Level is not high
enough you may trigger on the second or third sound rather than the first. You want to
find a setting where the two rows of dots are closest together and most stable.

Each row of dots is one side of the beat. The distance between the rows is the beat
error. In Figure 13 we can measure this at the Y axis to be .002 seconds (2 milliseconds).
If the watch is very fast or very slow, the slope of the lines may be so extreme that you
don’t see them as simple, nearly parallel lines. In this case, click on the “down arrow”
icon to reduce the vertical scale of the display until you can see two lines at some slope.

If the two lines are very close together you can easily “zoom in” on them to more accurately
measure the beat error. Just click on the “up arrow” icon to increase the vertical resolution
until you can easily measure the separation between the two lines.

With conventional paper tape timers you would use a protractor to measure the slope of
the lines to derive the amount of error per day. With MicroSet we can view this value
much more easily by simply looking at the top right corner of the screen where the
Average Error is displayed. As long as the Target Rate was entered correctly, the Average
Error will correctly show you the error per day of the watch.

As with a paper tape timer, if the data lines wander off the edge of the “tape”, they will
wrap back on at the other side. This makes it difficult to evaluate fluctuations in the rate
because they can be “swamped” by the slope of a rate error. The computer makes it
easy for us to eliminate this problem. If you click on the “autoscale” icon, MicroSet will
automatically change the Target Rate to be equal to the current Average Rate. The
effect of this is to remove the slope of the lines caused by rate error, because there is
now, at least theoretically, no rate error at all. The lines will lose their slope and become
roughly horizontal, and you can see irregularities in them much more easily.

Paper tape machines had no choice but to display single dots for each beat. With the
MicroSet software, when a watch is erratic and the dots are not arranged in nice parallel
lines, you may be able to view the data more easily by clicking on the “vertical lines”
graph style icon. The information displayed is still the same, but you can more easily
see how an “outlying dot” relates to the dots around it. To return to the conventional
paper tape display, click on the “double-dot” graph style icon.

If you wish to leave the paper tape mode, click on the “Show: Rates” button at the top
left corner of the screen. This will revert to a vertical line graph of each beat.

This display mode is actually a very good way of being sure you have the Level control
adjusted properly. Every other line should be higher or lower than it’s neighbor in a
perfectly regular pattern. In Figure 14 you can see an example of this display. The first
half of the data was captured with the Level control set too low. The beat readings are
erratic. The second half shows the same watch with the level control turned fully clockwise.
Now the beat readings are perfectly regular and much more closely spaced. You should
use this display with the column graph to set the Level control before you bother trying
to use the paper tape display.
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Figure 14 - Adjusting the Level control

Accutron Rate
The second item under the Watches Menu allows you to capture the rate of Accutron
and other tuning fork watches on the computer. This function will not work on MicroSet
2. You must be using MicroSet 3, which has an Accutron Mode. Plug the optional Accutron
sensor into the timer’s Sensor In jack. Set a tuning fork watch on the sensor so the 12
o’clock position is near the center of the sensor. Press the MODE button on the timer
until the LCD screen says “Accutron...” and press BEGIN. The LED on the front of the
timer should come on to indicate that it’s getting a signal.

When the timer is set up and measuring a watch, select “Accutron rate” from the Watches
Menu. MicroSet will change it’s display mode to show numbers with three decimal places,
which is the resolution of frequency readings from the timer. If you have clicked “Plot:
On” to begin taking readings, you should see the “# of Samples” increasing, but you
may not see any data on the computer screen. This is because the values are very high
and are usually off scale. Click on the “Autoscale” icon to set the Y axis values so the
Accutron frequency rate will be on the screen. You should now see a new reading from
the timer about once every second.

If you wish to have the program show you the error per day, simply set the Target Rate
to the correct frequency for the watch. The most common value is 360 (cycles per
second).

You will find that the fork frequency of Accutron watches varies with temperature and
position. There’s even a little wobble to the rate as the minute hand passes the 12 each
hour.

Analyze tick sound
This function is not available in MicroSet 2 and requires MicroSet 3. It will show you a
graphical representation of a watch tick, including the component sounds and a calculation
of the balance wheel amplitude. It’s a little complicated to describe. Please read the
following explanation patiently!

Note that we have now created an improved version of this function. It’s called Balance
Wheel Amplitude and will be described next. It requires additional hardware in your
timer to use it.

Before you use the Tick display function you should understand what it shows you.
When we hear a watch tick, we hear it as a single sound. But when examined
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“microscopically”, there are actually several sounds happening one after another. The
primary sounds are the unlocking, the impulse, and the drop. If you’d like more information
on these sounds and what causes them, you can refer to a book on watch escapements.
Such an education is beyond the scope of these instructions.

The primary use of the relationship between these sounds is to divine the amplitude of
the balance wheel. But we can also learn to identify watches that have “clean” and clear
component sounds and those that have noisy escapements.

To use the Tick Display function, set MicroSet 3 to the Tick Mode and press BEGIN. Put
a watch on the sensor and set the Level control to about the 12 o’clock position. On the
computer, choose “Analyze tick sound” from the Watches Menu. You will see a new
window similar to the one shown in Figure 15.

Figure 15 - Analyzing the tick

The wide rectangular yellow area  is the graph area where the tick sounds are displayed.
The sounds are displayed as a single red line. If there is sound at a particular instant,
the red line will be at the top of the graphing area. If there is no sound, the red line will be
at the bottom of the area.

At the bottom of this window is a scale of milliseconds. The range starts at zero to 100
milliseconds. Some slow ticks might take as long as 70 or 80 milliseconds, but mostly
the total tick duration will be closer to ten milliseconds. In order to see the sounds of
your watch more accurately, there is a “Zoom In” button. Every time you click on this, the
horizontal scale will be expanded. In Figure 15, I have “Zoomed In” until the total graph
shows 25 milliseconds of time. There is also a “Zoom Out” button.

As the watch ticks, the sound signal is analyzed and transmitted to the computer at
intervals of half a millisecond. The raw watch tick is a very messy signal, and this method
cleans it up and simplifies it for viewing. Even so, the setting of the Level control is
critical. You almost certainly do not want the Level set fully clockwise. This will amplify
the tick so much that all you’ll see is a big burst of noise. Start with the Level control near
the 12 o’clock position. You want to find a setting where you get three or four distinct
sound pulses, similar to what you see in Figure 15.

But the watch is ticking much faster than the software can transmit and display it. The
sound information is “buffered up” in the computer so every tick can be seen. But this
means that, after a short while, the ticks you are looking at happened some time ago.
When you make an adjustment to the Level control, it will affect ticks that you may not
see for several seconds. Every time you make an adjustment to the Level control, click



Page 35

on the “Reset” button to clear the memory and make the new ticks visible immediately.

If you wish to stop the display for a while and examine a single tick, you can click on the
“Pause” button. You can restart the display by clicking on “Resume” or “Reset”.

A good quality watch that is running well will have distinct sound pulses. You will find
that they often alternate -- the even ones will all be similar and the odd ones will be
similar but different. That’s because the balance wheel changes directions. The Tick
Display will allow you to evaluate subtleties of operation of the watch escapement after
you have become familiar with it. Some watches will have three clean sounds, others
will reveal four or more distinct sounds. Refer to a book on watch escapements for more
information on these sounds.

The most significant information to be gathered from the Tick Display is the amplitude of
the balance wheel. This can be predicted from the position of the sounds within the tick.
Simply put, the distance of the third sound (the drop) from the beginning of the first
sound (the unlocking) indicates the amplitude. The top of the Tick Display window is
labeled in degrees of amplitude. These values are calculated with the aid of certain
parameters for the particular watch. Specifically, we must know the Beat Time and the
Lift Angle. The default values are a Beat Time of 18000 BPH and a Lift Angle of 52
degrees. You can change these settings by clicking on the “Change Settings” button. It’s
easy to know the correct Beat Time of a watch. You must also know the Lift Angle to get
an accurate prediction of balance wheel amplitude. This value is commonly 52 degrees
for wrist watches and 36 degrees for pocket watches.

Referring to Figure 15, you can see that the beginning of the third sound happens between
the marks for 223 and 192 degrees at the top of the tick display window. To get the exact
value of the amplitude, move the mouse pointer over the tick display window. The pointer
will turn into a crosshair. Position the crosshair over the rising edge of the third sound.
The value of the balance wheel amplitude for this point will be displayed in the smaller
window above the tick display graph. The amplitude of this balance wheel is 203 degrees.

When you have finished with the Tick Display function, click on the “Done” button.

You can get a much more accurate reading of the watch tick and the balance wheel
amplitude by upgading your timer to have the additional hardware required for the
“Balance Wheel Amplitude” function, described next.

Balance wheel amplitude
This function is in improved version of the Tick Mode. It’s an extra-cost option because
it requires additional parts to be installed in the timer. Working in conjunction with the
Windows Interface software version 3, it will show you a high resolution graphical
representation (an “oscillogram”) of a watch tick and automatically calculate the balance
wheel amplitude.

When we hear a watch tick, we hear it as a single sound. But when examined
“microscopically”, there are actually several sounds happening one after another. The
primary sounds are the unlocking, the impulse, and the drop. The primary use of the
relationship between these sounds is to divine the amplitude of the balance wheel.

To use the Balance Wheel Amplitude function, set MicroSet 3 to “BW Amplitude” and
press BEGIN. Put a watch on the sensor and set the Level control to about the 10
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o’clock position. On the computer, choose “Balance Wheel Amplitude” from the Watches
Menu. You will see a new window similar to the one shown below.

Figure 16 - Balance Wheel Amplitude

The wide rectangular yellow area  is the graph area where the tick sounds are displayed.
The sounds are displayed as a red line. If the sound is loud, the red line will move
towards the top of the graphing area. If the sound is quiet, the red line will move towards
the bottom of the area. Turn up the Level control slowly until you can see three main
bursts of sound. The first burst begins the wave at the left edge of the graph. The second
burst will be a smaller hump in the signal. The third burst will be the tallest hump. The
highest burst should go to the top of the yellow graphing area and flatten out.

The setting of the Level control will be lower for this function than you usually use with
MicroSet. If the Level is not high enough, the tall burst will appear to jump left and right
and not hold position. Raise the Level control a little farther so the display is generally
stable. There will always be a little fluctuation from one beat to the next.

If you raise the Level control too far you won’t get any display at all. Turn it back down to
9 o’clock and start up again slowly.

A good quality watch that is running well will have at least three distinct sound pulses.
The Balance Wheel Amplitude display will allow you to evaluate subtleties of operation
of the watch escapement after you have become familiar with it. Some watches will
have three clean sounds, others will reveal four or more distinct sounds. Refer to a book
on watch escapements for more information on these sounds.

Reading the balance wheel amplitude
MicroSet calculates the amplitude of the balance wheel from the position of the sounds
within the tick. Simply put, the distance of the third sound (the drop) from the beginning
of the first sound (the unlocking) indicates the amplitude. A thin black line is drawn from
the top of the amplitude window to the red trace at the point where the amplitude is read.
Sometimes there will be an earlier sound that’s louder than the drop, and MicroSet will
read a false amplitude. If this happens you can turn down the Level control on the timer
so the third main sound is the loudest one. The calculated reading of balance wheel
amplitude is shown at the bottom of the window.
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There is an averaging function that will extract the “Drop” sound from a noisy escapement.
On the right side of the Balance Wheel Amplitude display are buttons labeled “Single”
and “Average”. When the Balance Wheel Amplitude function starts up, it displays and
average of several ticks. If you click on the “Single” button, MicroSet will display the
sound of single ticks as they come in. Such readings will be more individualized but
more coarse and less accurate. With the average function, the important sounds of the
escapement will become enhanced and the background noise will be reduced.

The balance wheel amplitude calculation depends on the geometry of the watch.
Specifically, we must know the Beat Time and the Lift Angle. The default values are a
Beat Time of 18000 BPH and a Lift Angle of 52 degrees. You can change these if your
watch is different. It’s easy to know the correct Beat Time of a watch. You should also
know the Lift Angle of your movement to get an accurate prediction of balance wheel
amplitude. This value is commonly 52 degrees for wrist watches and 36 degrees for
pocket watches.

A “Pause” button will allow you to freeze the display so you can take a more leisurely
look at the display.

A “Print” button will print a copy of the amplitude window on your printer.

A “Comment” button will insert the current value of the amplitude in the comment line at
the top of the graph area.

When you have finished with the “Balance Wheel Amplitude” function, click on the “Done”
button.
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The GPS Menu
This menu contains commands that are primarily used with the optional GPS Interface
hardware. This hardware lets you synchronize your readings to a source of precision
seconds pulses. This is usually a GPS receiver, but an “atomic clock” (rubidium reference
oscillator) or other source of precision seconds pulses will work just as well. Instructions
for hooking up the GPS Interface come with it.

The general idea with these interfaces is to provide a reference signal that is more
accurate than the oscillator that’s inside of MicroSet, so you can measure precision
clocks more accurately. They can also be used for very accurate measurements of
temperature effects on clocks. This is because the timebase in MicroSet can be slightly
effected by temperature changes. The precision reference will not be.

When MicroSet is used with one of these interfaces, the readings you get are the drift of
your clock relative to the precision reference, not the rate of the clock which MicroSet
normally gives you. The GPS interface is designed to work on clocks with a one second
pendulum, but it can also be used with half second clocks if they are configured to
trigger the timer once per period rather than once per beat.

Show drift
This command will automatically remove any value jumps that happen when the reference
pulse and the clock "tick" come into phase. The resulting data set will be stored in the
alternate (blue) data area. Also, when this command is issued, the first offset value is
set to zero and all other values are adjusted by the same amount. Since the actual
offset amount is immaterial, this results in a data file that shows absolute drift in the
clock, from a starting point of zero. The original data, with the value jumps still in it, is
kept in the normal (red) data area.

Convert to rate
This function will calculate the actual rate of the clock by dividing the total amount of
time by the total amount of change. When you select this command, a dialog box will
ask you for the sample range. Enter the number of samples over which you wish to
perform this calculation. For example, if you enter "10", the total time spanned by samples
one to ten will be divided by the total drift over these ten samples to give a rate value.
Data point ten will be set to this rate value. Then, the total time spanned by samples two
to eleven will be processed the same way, and data point eleven will be set to this rate.
The rate values will be stored in the alternate (blue) data area. The original raw offset
values will still be stored in the primary (red) data area.

Calculations made with a small span of samples will have less precision than
calculations made with a longer span. On the other hand, shorter spans will reveal
rate changes of shorter duration than longer averages. The resolution of the GPS
Interface in this application may be about 5 microseconds per sample. If you convert
to rate with a span of 6 samples (60 seconds) you get an average rate over 60 seconds
with a precision of 5 microseconds per minute (one part in 12 million). If you convert
to rate with a span of 360 samples (one hour) you get an average rate per hour with
a precision of 5 microseconds per hour (one part in 720 million). You can perform
this calculation over and over, with different sample ranges, without disturbing the
raw data.
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Monitor receiver status
This command will allow you to monitor the number of satellites the optional GPS
Reference Receiver is able to identify. When you use the GPS Reference Receiver to
measure a precision clock, you need to know if you have located the GPS antenna in a
good location. A good location is one where the receiver can always see at least three
satellites. The Monitor Receiver Status function will plot out the number of satellites the
receiver is able to see every second. If you let this function run for a few hours you can
see if your receiver is always able to communicate with enough satellites.

To use this command, unplug the MicroSet timer from the computer and plug in the GPS
Reference Receiver’s serial output instead. A new reading will be generated every second.
You probably don’t need a reading every second, so tell the computer to “Skip” a number
of samples under the Operation Menu. Select Monitor Receiver Status from the GPS
Menu and click on “Plot: On” to begin capturing satellite status.
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The CONFIGURE Menu

Autosave
This command will allow you to automatically save the current data at specified times.
This will help insure that you will not loose a lot of data if the power goes off or the
computer crashes when you aren’t around.

When you select "Autosave" a dialog will allow you to enter the number of samples to
wait before saving the data. After you enter the number of samples, click on "Start Auto
Save" and you will be able to enter the name of the file to save under. To turn off Autosave,
click on "Stop auto save".

If you’re using the “Pre-average” or “Skip” functions, the number you enter refers to the
number of readings actually stored in the graph, not any of the readings that are skipped
or averaged.

Let's suppose you were gathering data with 60 beat average on a one second pendulum
with a pre-average of 10. This means that a new value would come out of the timer
every minute, but that these values would be averaged by the software ten times before
a value was saved in the program. If you tell the "Autosave" dialog to save after three
samples, you will write the current data to disk every 30 minutes.

Setup
This selection let’s you configure the software for several settings that you wish to
preserve. All of these settings can be memorized by the program so it will always use
your configuration.

Figure 17 - Setup
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To select a serial port, click on the radio button that corresponds to that port. MicroSet
only works through serial ports. If your computer has no serial ports and only has USB
ports, you can use a USB to serial converter to create a virtual serial port. To see which
serial ports are available on your machine, use the Device Manager to display them.

You can choose to have the program display pendulum lengths as inches or centimeters.
You can choose to have temperatures displayed as Centigrade or Fahrenheit. You can
have the barometric sensor display readings as millibars or inches of mercury.

There’s a check box to “Store date with time.” If you set this, the time stamps saved in
the computer files will record the date as well as the time of day. This will make the file
a little larger, but it can be useful if your data runs over many days.

There are text boxes where you can enter a trim value for “Temperature 1” or for “Baro
Temperature”. The two temperature sensors are not perfect. They have an absolute
accuracy of about half a degree Centigrade. If you wish to calibrate the sensors, or
make sure they match each other, you can enter a trim value that will be applied to
every reading. In this way you can characterize the two sensors you have and make
them more accurate.

You can also choose whether or not to always show the custom text above the graph
area, and what that text will be. You might want to enter your business name to identify
who worked on the clock or watch and who produced the graph when you print them
out.

There is also a comment about which humidity sensor the program is calibrated to work
with. This is necessary because there are a couple of different sensors in use. If you
don’t have the optional atmospheric sensor, this message does not matter to you.

Once you’ve made your selections, click on the OK button. The program will try to
accept your selections and go back to work. If the serial port you selected is non-existent
or already in use by some other program, you’ll get a warning message. Otherwise, the
program will resume operation with the new settings.

If you want the program to remember the settings you’ve selected, you must click on
“Save settings”. This will save the selections on your hard disk for the next time you run
the program.

Window size
This command will let you specify the size of the program’s window as a specific number
of pixels. You can always re-size the window in the usual way, by dragging a corner or
side. But it is sometimes helpful to have the window be a specific, known size. We often
do this before capturing an image of the program window for printing or posting on the
Internet.

To capture an image of the program screen, press the PRT SCR key on the computer’s
keyboard. This will place a copy of what’s on the computer screen in the computer’s
“scratchpad”. You can now paste this image into an image editing program like Paint or
PhotoShop.
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Using the MicroSet Computer Interface
—————————————————————————————————————
There are probably two categories of users: those whose work with clocks and watches
in the repair trade, and those whose interest is more theoretical and experimental. The
computer interface has value to both of you.

The repair trade
Several repairmen have told me that they find the graphs very useful as a sales tool.
You can prepare a graph of the clock before cleaning and after cleaning to show
improvement. Such improvement might be very noticeable in the “Instability” factor. If
you don’t wish to provide a “before and after” comparison (or if the clock didn’t run when
it came to you), a formal looking graph of the clock’s performance after service can
make you seem like a very sophisticated and accomplished technician. You can add a
description of the data and your shop name in the Comment Window at the top of the
graph.

In your shop, you will probably find that it’s much more useful to evaluate a clock’s rate
after it’s run for half an hour or more on the computer. You already know that individual
readings are somewhat erratic. When you see the half hour history of these changes
you’ll be in a good position to evaluate how the clock is performing. Experience will
teach you what to expect and what to look for.

Pay attention to the position of the clock hands. When you capture the rate for an hour,
you will see that many clocks speed up as the minute hand falls from 12 to 6, and slow
down as it is raised up again. Be sure that the clock hands match the computer’s system
clock.

You can get a very precise reading of whether or not a clock or watch is “in beat” by
capturing every beat on the computer (set MicroSet to “Time: 1”). Every other reading
will be bigger or smaller than it’s neighbor, and the difference between them is  the
amount of beat error in that clock or watch. MicroSet will show you this error to a millionth
of a second.

Some clocks respond to rate changes pretty quickly, others take many minutes. I have
clocks that can take more than an hour to settle down after an adjustment is made. If the
computer is logging the rate while you adjust it, you will be able to see from the “rate
curve” when a clock has stabilized and it’s worth taking another look, or if the clock is
still “coming to speed” after an adjustment.

Another situation not everyone is aware of is that, if a heavy pendulum has not been
hung for a while, a clock can take really a long time (overnight) to “settle in” and stabilize
it’s rate. I have a rate graph of a clock with a five pound bob that continued to slow down
for more than 24 hours after it was reassembled. The shape of the rate change over
time clearly shows if the rate has flattened out or if more change is yet to come.

You will also benefit from considering how the rate changes. If there are specific periods
of increase or decrease, try to understand what caused those changes. The duration of
any cycles reflect the mechanism that caused them. We have seen that a 25 beat cycle
reveals the rotation of the escape wheel. Other wheels in the clock or watch also have
natural periods of rotation, and rate cycles can be traced to individual wheels.

Flaws in the escape wheel can be dramatically revealed by plotting every other beat
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with the acoustic sensor. The rate will always change in cycles, but if there is any
extraordinary pulse to each cycle it will be due to a particular tooth. You will want to use
the acoustic sensor for these readings because they measure from the sound of the
pallet striking the wheel. You will not be able to study the escape wheel in a clock by
watching the pendulum with the optical detector.

To get a general idea of how a clock performs I like to look at the “Instability” factor.
Some clocks will naturally have a higher rating than others, but experience will teach
you what range of values to expect for a certain type of movement. When a clock comes
in with a very sloppy Instability it’s time to look closely at it.

You can record the strike counts from the Strike Mode on the computer. This will not
only record the number of times the clock strikes, but also the time of day that the strikes
occur. This can help you diagnose clocks that strike the correct number of times but at
the wrong time.

You can record the individual counts from the Rate Finder on the computer. This can
make it easy to identify a bad reading that might throw off the average.

Experimental applications
The horological experimenter will no doubt have his own agenda of issues to look at, but
I have found several issues that I think are rather interesting.

The ability to log changes in amplitude of very fine scale is incredibly useful. In my own
work, making clocks with electromagnetic impulse, the amplitude measurement makes
it easy and fast to evaluate changes in the efficiency of impulse. This would also work
with conventional escapements. In the case of my electromagnetic clocks, if a change
in the position or duration of the impulse improves the efficiency, the amplitude will
begin to increase on the very next stroke. The computer reveals this long before it would
be visible to the naked eye. If a change disturbs the impulse, the amplitude immediately
begins to decline. With conventional escapements you might not be able to get the
same instantaneous feedback, but you could certainly measure the amplitude from one
run to the next in fine degrees and observe changes.

I have also found that, though you would expect the rate of a free swinging pendulum to
speed up with decreasing arc (due to circular error), it sometimes slows down instead.
I have personally seen this effect to be caused by residual magnetic fields acting on the
pendulum, by some sort of interference to the pendulum at larger arcs (the pendulum
colliding with a soft obstruction), and by loose clamps on the suspension spring. The
latter condition also caused extremely long settling times after a rate change was made.
Being able to plot rate and amplitude at the same time makes it much easier to investigate
these issues.

I have found it interesting to log the rate of spring driven clocks for an entire week to see
how they change under conditions of declining spring tension. This will also let you
evaluate the performance of a fusee.

Logging a clock rate over time as the temperature and barometric pressure change are
obvious cases for the experimenter. These measurements allow you to evaluate different
pendulum and bob materials and different mechanisms for environmental compensation.
Fabricating and calibrating compensators is made much easier with the MicroSet sensors.
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On clocks with very high precision, the accuracy of the timer itself can become a limitation
because it can vary by a couple parts per million over several degrees of temperature
change. You can buy an optional Temperature Compensated Crystal Oscillator for
MicroSet, or the GPS Interface allows “absolute” accuracy of readings over months at a
time, regardless of temperature changes. These accessories allow us to observe thermal
compensation in the pendulum, barometric pressure response, and even tidal effects in
pendulums of adequate precision.

Technical Support
If you run into difficulty there are several ways to contact us listed on the back cover of
these instructions. Feel free to give us a call or send an email if you need help.

From time to time there may be enhancements to this software or new versions. Feel
free to give me a call and inquire. I would be happy to receive any comments or
suggestions you may have about what this software does or how it performs. It continues
to evolve based on the feedback of the people who use it and my own ongoing
experiments.

Bryan Mumford
Santa Barbara, California
September 22, 2005


